
Urban Experience
GCSE MOCK EXAM



Term 5 – 6 weeks

WEEK 1;

Develop a range of ideas – mind mapping

WEEK 2-5;

Investigate 3+ photographers/artists, with full 

responses to each one.

WEEK 6;

Respond to all three photographers and 

present the results.

Term 6 – 6 weeks

WEEK 1-2;

Complete outcomes for at least 2 

different photographers

WEEK 3;

Combine ideas from those photographers 

to arrive at a final idea

WEEK 4; 

• Produce final outcome 4 hours

7th July

MOCK EXAM 2023 OVERVIEW



1. Title page

2. Mind map/s

3. Statement of Intent

4. Min. of 3 artist/photographer research/analysis

5. Min. of 3 sets of images (if you attend the trip, you can easily take 90+ photographs which would be enough) 
and edits from these

6. Experimentation (using a range of materials, techniques and processes) that clearly shows refinement and 
the development of ideas. 

7. Annotation & evaluation throughout

8. Statement of Intent for final piece/s

9. Mock up/plan for final piece

10. Final piece/s

11. Final annotation/evaluation

COURSEWORK EVIDENCE REQUIRED



HOW TO START

Choose from one of the following topics, 
this will be the starting point for your 

examination project. 



TEXTURE



TEXTURE

AARON SISKIND AARON SISKIND

IRVING PENN

Click to add text
Click to add text
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Click to add text
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TEXTURE Mimmo Rotella



TEXTURE

Ludovica Gioscia

Colin Brown​

Ludovica Gioscia

Click to add text



TEXTURE

William Klein ‘Contact Sheets'



TEXTURE

Sven Pfrommer



FASHION



Nike React IG Campaign

By Tran La



Pilar Rius

Click to add text



Andreea Robescu

Other related artists:

Hattie Stewart

Ana Strumpf

Camille Walala



Emilia Elfe



Derek Gores



ABSTRACTION
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Jim Kazanjian

Paul Citroen

Anastasia Savinova



Helene Binet Richard Galpin
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John Clang

Fong Qi Wei
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Jeffery Meyer

Paula Zinsmeister

Jelle Martens



Create a Title Page and Mind-Map 
based on your chosen option

HOW TO START
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CREATE A VISUAL MIND-MAP

This must contain at least 18 images. This must be made from 3 images from at least 6 
different photographers who demonstrate a different method of responding to your 
chosen topic.

The examiner wants to see that you can explore A RANGE of ideas first before focusing 
in on your chosen artists, so this slide is an important step in that process.

You also need to include the names of each of the photographers and at least 10 key 
adjectives to support a description of the topic and the kind of work you have chosen to 
focus on. 

Establishing these words now, will then help you describe the work when it comes the 
more in-depth artist research.



PEELING SURFACES

DARKROOM PRINTING & 

DECOLLAGE

PHOTOGRAPHING OBJECTS

 ON PHOTOS

MIXED MEDIA

LAYERED INFORMATION

WILLIAM KLEIN

STEPHEN GILL
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1st Homework: Due Thursday, 20th April

Use Pinterest to search for more ideas that relate to your theme.

For example, if you chose ‘Urban Experience Texture’, you could look for:

• Urban texture

• City texture

• Street Texture

• Search for the artists names on your A3 sheet – Pinterest will bring up 
linked images that you can use as inspiration

Save the images you find and create a 2nd Mind-Map of your own exploration



Select at least three of the photographers from your chosen topic and 
include pictures of their work

Explain what you like about each of the images

Explain how it links to the wider topic of Built Environment

Say what techniques you can see that you are interested in exploring and 
how you might hope to use them to develop your ideas.

Which photographer would you like to focus on first to start making 
your work? What type of images will you need to be able to start 
experimenting?

CREATE A STATEMENT OF INTENT



Statement of Intent
I have chosen to focus on the theme of ‘Texture’ because I am drawn to 
the collage technique and I think it will be able to capture loads of 
different textures in East London. I will be able to photograph colourful 
street art and close up details of where posters and stickers have started 
to decay and become distressed. I will also photograph textures found on 
the street, like pavement, brick work, shop signage, grates and drain 
covers.

I also like how this project will allow me to combine some mixed media 
aspects like the paint pulls seen in Sven Pfrommer’s work. I really like the 
neon paint palette that Gioscia uses and how Rotella also has elements 
of abstracted lettering.

I aim to experiment with physical collage techniques – like decollage, 
where I build up layers and then tear or cut away to reveal the 
underneath. I would also like to try this combining some dark room 
prints. I will create some paint scrape textures that I can overlay on my 
images, print them, then collage. I would like to try working on a larger 
scale, I will create some smaller tests on board to see how successful it 
is. If it works I could work on A2 board to create larger sc

]e works like Gioscia’s. I think by adding the paint scrape scans will work 
well because I can manipulate them to match the neon colour palette in 
her work, the neon colours would create vibrant contrast against the 
dark room prints.

I will start looking at Rotella’s work and will make some dark room 
photograms using Letraset and wooden letters to create interesting 
compositions. Then I will collage these and also scan them in and overlay 
neon colours, print them and explore the decollage technique.
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Learning Objective: 
Investigate the work of a photographer, showing an understanding of the 
Visual, Technical, Contextual and Conceptual aspects of their work.

Tasks: 

• Create 1-2 new slides that focus on the first photographer you would 
like to respond to.

• On these slides, include a brief introduction to the photographer 
and the analysis of one image that you find most inspiring. Include 
this image on the slide. 

Star Tip: Choose the photographer whose work you 

feel most confident at being able to replicate first. 



• What is it called?

• Where was it taken? 

• When was it taken? 

• What else was happening in 

the world then? 

• What do you think the photographer 

might be trying to show or say? Think 

about the main issue

• What is your personal opinion about the work 

– how does the image affect YOU?

• What does the photograph make you feel or 

think about? 

• What is the subject matter of the photograph? 

• What is the focal point (what is your eye drawn to 

first, and then what else?)

• Where is the light coming from? Both direction and 

source!

• Is there a strong tonal contrast?

• What colours are there? 

• Can you overlay lines/shapes on to the image to 

show the structure of the composition?

• Is it film or digital?

• Has it been manipulated? If so, how?

• How would you describe the depth of 

field used? (Is it shallow or wide?) What 

areas in the photograph are in focus 

and what areas are blurred?

• What type of shutter speed do you 

think has been used (fast or slow?) and 

why do you think that?



Visual

• What is the subject matter of the photograph? What is 
the focal point (what is your eye drawn to first, and 
then what else?)

• Describe the composition of the photograph – can you 
identify a compositional principle? (eg. Leading lines, 
strong angles, balance, repetition etc. 

• Can you overlay lines/circles on to the image to show 
the structure of the composition? (see an example of 
this on slide X)

• What are the key formal elements used in the 
photograph? How do they work to create a successful 
photograph?

Key Terms to Consider and Use:

Formal Elements

 • Colour ( & Colour Theory terms) • 

Tone (light & dark) • Texture (surface) 

• Shape (2D, flat) • Form (3D) • 

Pattern (repetition) • Line

Composition:

Layout, arrangement, organisation, 

selection, cropping, 

containment/confinement (within 

frame), Leading lines/leading the eye, 

Emphasis, Repetition, Viewpoint, 

Balance, Harmony, Contrast, Tension, 

Foreground, middle ground, 

background, Rule of Thirds, Golden 

Section/Ratio, Depth of surface 

illusion... 



TECHNICAL 

What type of lighting do you think has been used? (and what 

evidence tells you that?)

How would you describe the depth of field used? (Is it shallow 

or wide?) What areas in the photograph are in focus and what 

areas are blurred? 

What type of shutter speed do you think has been used (fast or 

slow?) and why do you think that?

VISUAL

What is the subject matter of the photograph? What is the focal point 

(what is your eye drawn to first, and then what else?)

Describe the composition of the photograph – can you identify a 

compositional principle? (eg. Leading lines, strong angles, balance, 

positive/negative, repetition etc.

What are the key formal elements used in the photograph? How do 

they work to create a successful photograph?

CONCEPTUAL

What do you think the photographer might be trying to show? 

Is there a message they could be trying to say? (What is it and why do 

you think that?) Is the work trying to highlight a point?

What is your personal opinion about the work – how does the 

image affect YOU?

How does the photograph make you feel? Why do you think you 

feel like this? 

What do you like or dislike about the image and why? Use 

PHOTOGRAPHIC TERMS to justify your opinions A
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CONTEXTUAL

Can you give some context to the photograph? 

The context of the photograph could be:]

Historical:

Place in time, local/national/global events

Visual:

Does the photograph belong to a wider art/photographic movement, 

genre, style

Personal:

What is the background of the photographer – have their personal 

experiences shaped their view



Technical

• What type of lighting do you think has been 
used? (and what evidence tells you that?)

• How would you describe the depth of field 
used? (Is it shallow or wide?) What areas in 
the photograph are in focus and what areas 
are blurred? 

• What type of shutter speed do you think 
has been used (fast or slow?) and why do 
you think that?

Key Terms to Consider and Use:

Lighting:

 Type of lighting E.g. natural/daylight, 

tungsten, flash, fluorescent, shade... 

Level of control E.g. 

positioned/located, reflected, 

manipulated, intensity, distance... 

Relevant key words: tonal range, 

contrast, saturated, over / under 

exposed, glare... 

Aperture: Lens (lens size, macro, 

telephoto, wide angle, settings: f-

stops...) Focal point, depth of field 

(DoF) – shallow/wide, sharp, focused, 

blurred, vignette... 

Shutter Speed: Exposure time, 

over/under exposed, motion blur, 

sharp, frozen, panning... 



Contextual

• Can you give some context to the photograph?

To answer this, you will need to research the selected 
photograph to find wider background information 
about the work.

We have deliberately chosen photographs that you 
will be able to find ‘context’ for!

You have been given the photographer’s name, 
the title and date of the work to aid your search.

Key Terms to Consider and Use:

Context Definition:

The circumstances that form the setting 

for an event, statement, or idea, and in 

terms of which it can be fully understood.

Eg. The context of the 

photograph could be:

Historical:

Place in time, local/national/global 

events

Visual:

Does the photograph belong to a 

wider art/photographic movement, 

genre, style

Personal:

What is the background of the 

photographer – have their personal 

experiences shaped their view



Conceptual

• What do you think the photographer might be trying to 
show? 

Is there a message they could be trying to say? (What is it and why 
do you think that?) Is the work trying to highlight something?

• What is your personal opinion about the work – how does 
the image affect YOU?

• How does the photograph make you feel or think about? 
Why do you think you feel like this? 

• What do you like or dislike about the image and why? Use 
PHOTOGRAPHIC TERMS to justify your opinions.

Key Terms to Consider and Use:

Concept Definition:

An idea, plan or intention

Sentence Starter Ideas:

‘I think the photographer is trying to 

show……………..and I think they have 

done this successfully because…………’

‘I think this is a good photograph 

because of how the photographer has 

shown/used/chosen……etc’



Making your first visual response

• Through your research you should have determined how your chosen 
photographer created their work.

• This may not be exactly how you go about responding but the outcome 
should show a clear link

• You should ideally use your London images to start making this response

• You should make at least three similar but different outcomes.

• During each edit try to move the idea on and find a more personal 
response.

• Try to refine and personalize the idea a little more with each outcome. 



Exploring your own ideas. 

The following slides show a series of methods to explore creative ideas. 

Although they are sectioned in to the three various topics this does 
not mean you can not explore any idea, from any section with your 
images. 

Have a look through and gain some inspiration to start exploring your 
own ideas. 



Term 5 – 6 weeks

WEEK 1;

Develop a range of ideas – mind mapping

WEEK 2-6;

Investigate first two photographers/artists, with 

full responses to each one.

MOCK EXAM 2023 OVERVIEW
Term 6 – 6 weeks

WEEK 1-2;

Research final initial photographer and 

produce visual responses

WEEK 3-4;

Combine ideas to arrive at a suitable, 

personal response to produce in the final 

controlled time

Week 5; 

Prep and complete a final outcome based 

on all your preparatory work. 

Week 6; 

Assess project as a whole to establish 

strengths and weaknesses



TODAYS TASKS. 

You must do one of these tasks and 
demonstrate your progress at the end of 
the lesson

Completing a response to a chosen photographer. 

Completing a research in to a 2nd photographer



The only way to gain marks is to produce work of an increasingly 
better quality. 

Just doing it “because” is not enough to create a successful 
outcome. 

YOU need to REFLECT and REFINE your own ideas 

Be curious! Get ideas from elsewhere. Search YouTube or 
Pinterest for tutorials! Be inventive! 

Exploring your own ideas. 



Term 5 – 6 weeks

WEEK 1;

Develop a range of ideas – mind mapping

WEEK 2-5;

Investigate 3+ photographers/artists, with full 

responses to each one.

WEEK 6;

Respond to all three photographers and 

present the results.

Term 6 – 6 weeks

WEEK 1-2;

Complete outcomes for at least 2 

different photographers

WEEK 3;

Combine ideas from those photographers 

to arrive at a final idea

WEEK 4; 

• Produce final outcome 4 hours

7th July

MOCK EXAM 2023 OVERVIEW



EXPERIMENTATION:

ABSTRACTION

Mirror Prism

Photograph the reflections of your work through 

mirrors or mirror prisms.

Create mirrored work in Photoshop.

Scanning/Photocopying

Use coloured sheets of plastic 

to overlay/layer on top of your 

printed photographs.

Photocopy on to a print to 

superimpose images together.

Move the print while the 

copier does the scan to distort 

the image.

Add colour using 

coloured gels on 

studio lightsCrop interesting sections to 

make a range of further 

abstracted compositions.

Duplicate, change scale/angle 

and blend mode the layer in 

PSD.



EXPERIMENTATION:

ABSTRACTION

Print off your images and decollage!

Explore some in colour some black and white

Oversized lettering collaged in will look good too

Print on to coloured paper

Print the same image but in different colours (change 

Hue/Saturation in PS)

Scan your collages in, edit, take cropped sections.

Digitally overlay your own ripped textures blend moding 

them on Photoshop



EXPERIMENTATION:

ABSTRACTION
Print off and splice on a guillotine, rearrange out of order and 

photograph/glue down

Print off and cut in to different sized rectangles and rearrange

Photocopy pages from a Letraset catalogue and do the above.

Create an abstract page of lettering in Photoshop in large font sizes, explore 

serif and sans serif fonts, print, splice and collage or photograph.
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Digital Manipulation
Using Photopea – try this tutorial that uses 

geometric shapes to abstract your images.

What type of images 

to search for/use:

East London Architecture

Shoreditch architecture

Barbican Building

TEA Building

Jelle Martens Photopea Tutorial - YouTube

Physical Manipulation
Use a craft knife (and cutting board!) to 

carefully remove sections of the building

Be sure to leave in the sections that show the 

perspective of the building

Make sure your image is small enough on the 

page so it leaves a border of at least a ruler 

thickness – without a thick border/edge your 

paper will get too fragile and tear easily.

Photo-

experimentation

• Shoot through windows – fogged up, steamed up, 

rained on

• Use post it notes to stick to window to add 

blocks of colour and play around with the depth 

of field so that the post it note appears as a blur 

of colour or sharp area of colour. 

• Apply strips of coloured tape (or similar) to a 

piece of clear plastic E.g. acetate. Then take a 

series of photographs looking through this 

disrupted surface, experimenting with focus and 

depth of field. Mirrors could be used to create 

further abstraction and paint could provide a 

less structured alternative or addition to the 

strips of tape.

Coloured tape/coloured acetate

https://www.youtube.com/watch?v=2XEnQRc9KGU
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Digital Manipulation
Using Photopea – try any of these easy to follow 

tutorials on Youtube from Mr E’s Art Club

Liz Orton Photopea Tutorial - YouTube

Giacomo Costa Photopea Tutorial - YouTube

Mariyan Atanasov Photopea Tutorial - YouTube

Physical Manipulation
• Find 3-5 images of buildings that show as much of the whole building as possible, find 

buildings that have been taken at different angles and perspectives

• Make images B&W (Image>Mode>Grayscale)

• Add halftone effect in Photoshop first to give the work an aged feel 

(Filter>Pixelate>Colour Halftone>Set the first box to 20 and the ones underneath to 0 

(You might want to adjust the 20 value to get the look you want)

• Print off images – use the photocopier to enlarge and scale down extra copies to work 

with.

https://www.youtube.com/watch?v=R2PlHKJWYYA
https://www.youtube.com/watch?v=sJxTmfuaMF0
https://www.youtube.com/watch?v=rSRHoSy5Lg4
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Digital Manipulation
Using Photopea – try any of these easy to follow 

tutorials on Youtube from Mr E’s Art Club

What type of images 

to search for/use:

Shoreditch Street 

Photography

East London Architecture

Barbican Building

Fong Qi Wei Photopea Tutorial - YouTube

Physical Manipulation

• Print on to acetate different images 

or the same image at different scales 

and then layer them on top of each 

other.

• Play with B&W and colour or a mix 

of both.

• Print off the image at different sizes 

and with different colour 

temperatures and create a joiner 

collage that on one side is cooler 

colours then blends to warm or vice 

versa.

Darkroom

• Print off the one image and 

then copy it 3-4 times on 

to separate sheets of 

acetate and then layer and 

make a print

• Print one image and then 

make a multiple exposure 

by moving the image every 

few seconds

• Distort the image by 

bending the acetate but 

holding it still

Digital Manipulation
Explore how colour (Hue, temperature 

etc) can make the image look like its 

been taken at different times.

Warmer/cooler colours could represent 

early/late in the day/night.

Stephanie Jung Photopea Tutorial - YouTube

https://www.youtube.com/watch?v=ZUR0vJkHKvw
https://www.youtube.com/watch?v=V-FuFEHmbFE


EXPERIMENTATION:

FASHION

To make some work like Tran La you will need:

Black and white geometric/op art patterns

Brand logos

Limited colour palette (one neon colour)

In Photoshop you could:

Use Polygonal tool to select the outline of the figure then right click and 

duplicate, then CTRL T the duplicated later to make it bigger and isolate the 

layer to be able to place other layers behind it.

Add coloured overlays (New Fill Layer>Solid Colour>Blend Mode)

Duplicate logo/text and place it behind your figure or as a frame.



EXPERIMENTATION:

FASHION

To make some work like Pilar Rius you will need:

Patterns – geometric, op art, photocopies/scans from colouring in book

Figures cut out from magazines

Felt tips

In Photoshop you could:

Use Polygonal tool to select the outline of the figure then right click and 

duplicate, then CTRL T the duplicated later to make it bigger.

Add coloured overlays (New Fill Layer>Solid Colour>Blend Mode)

Duplicate logo/text and place it behind your figure or as a frame.



EXPERIMENTATION:

FASHION

To make some work like Andreea Robescu

 you will need:

Leaf/flower shapes, brushmarks, text (optional)

Explore creating the above yourself (see pics)

Papercuts in 

coloured 

paper of 

leaves and 

flowers

Make paper stencils and sponge 

or dry brush in black paint and 

scan in

Magazine 

scan
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Décollage

You will need: Backing card in colour of your 

choice, gluestick, craft knife, min. of 2 printed 

images (but its up to you how many layers)

How to: 

• Decide on what will be the image revealed 

when you tear back the top layer – this image 

gets glued down really well to the backing card.

• Lightly glue and only lightly press down the 

next layer, then use a craft knife to make a 

small cut in the top layer to then tear down to 

reveal underneath

• Keep the torn off pieces – you could add them 

as extra layers on top to make more texture.

Other things to try:

• Combine B&W and colour prints or invert the image

• Make the prints whatever colour you want by applying a colour 

overlay before printing

• Create your own torn paper textures by tearing paper and 

scanning it in then creating digital decollages

What type of 

images to search 

for/use:

Shoreditch Street 

Photography

East London 

Architecture

Ben Eine East London



Marbelling

EXPERIMENTATION:

TEXTURE

Paint Dragging

Water Capture DARKROOM

Photographing through surfaces

Photographing distorted reflections



EXPERIMENTATION:

TEXTURE

Photocopying on to different surfaces

Photocopy some images on to buff sugar 

paper or old printed paper to collage with like 

Paul Citroen

(see image above)

OR

Invert the B&W images, print them on to acetate, cut 

and collage on top of light sensitive paper to make a 

darkroom print.



Mae Chevrette Emma Johnson

EXPERIMENTATION:

TEXTURE
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Digital Manipulation
Using Photopea – try any of these easy to follow 

tutorials on Youtube from Mr E’s Art Club

What type of images 

to search for/use:

Shoreditch Street 

Photography

East London Architecture

Barbican Building

David Carson Photopea Tutorial - YouTube
Physical Manipulation

• Handwrite or hand paint your 

own lettering and scan in to 

layer digitally

• Block print letters from the 

wooden letter blocks in the Art 

Office using printing ink

• Create paint scrape textures 

(grattage)

• Make letter stencils and sponge 

on the paint, then scan in and 

work with digitally

Darkroom
Using the plastic letter 

stencils and wooden letters 

create lettering 

photograms

Write using developer on 

exposed paper with a 

paintbrush

Digital Manipulation
Use the Polygonal tool to make 

your own letter shapes then use an 

artistic brush tool to create digital 

stencilled lettering
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https://www.youtube.com/watch?v=Uzz57HP8H9w


RESEARCH

RESPOND

EXPERIMENT

PRESENT



QUICK START RE-CAP

The Mock exam 
topic I chose was

A photographer I 
have looked at is 

A technique I 
have explored is



Establishing your own ideas 

URBAN EXPERIENCE
fashion – texture – abstraction 

Mimmo Rotella – Sven Pfrommer – 
Aaron Siskind – Stephanie Jung – 

William Klein - Tran La - Colin Brown – 
Andrea Robescu – Pilar Ruis – Derek 

Gores 



Establishing your own ideas 

This is often the most difficult part as 
it needs to come from you. 

This also means it is the most rewarding part 
as it is your ability to realise your own 

creative vision. 



Establishing your own ideas 

Think of two different photographers that you have 
looked at and complete part one of the help sheet 

At least one should be related to the Mock Exam 
topic but the other can be from anywhere else in the 

project or even from an entirely new source. 

Look; the visual appearance of the image Process; the method of creating the image

Focus on the LOOK and PROCESS of each 
image when you describe it 



Establishing your own ideas 

Pick two of the different photographers that 
you have looked at last lesson and describe 

what their work looks like and how you think, 
or can find out, it has been made.  

Look; the visual appearance of the image Process; the method of creating the image

Focus on the LOOK and PROCESS of each 
image when you describe it 



Establishing your own ideas 

Now you start to think creatively 

Find at least three ways to combine the 
look or process of those photographers 

Here you can combine an aspect of the look of one with the process of another 
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